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I. GENERAL PROVISIONS 

1. The description of the procedures for preparation, defense, assess-
ment and preservation of final research papers (theses) and academic writ-
ing (hereinafter referred to as the Description of the Procedures) of the Gen-
eral Jonas Žemaitis Military Academy of Lithuania (hereinafter referred 
to as the Academy) defines general requirements for preparation, defense 
and assessment of final research papers and academic writing in all study 
modes, the Academy›s first and second cycles, integrated studies as well as 
military preparation programmes and regulates the order of organization of 
their preservation.

2. The aim of this Description of the Procedures shall be to unify the 
form and content requirements raised in the Academy for all final research 
papers and academic writing under preparation. Methodological guidelines 
prepared by departments establish more comprehensive requirements act-
ing in compliance with the afore-mentioned Description of the Procedures.

3. The director of the Institute of University Studies and heads of de-
partments shall control the implementation of the Description of the Pro-
cedures. 

II. ACADEMIC WRITING AND FINAL RESEARCH 
PAPERS, THEIR SUBMISSION  

AND PRESERVATION 

4. Cadets, students and auditors (thereinafter referred to as the Stu-
dents) in the Academy during their studies prepare independent and group-
related written papers, formulate accounts of laboratory work and practice, 
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write academic essays, research papers, term papers, bachelor’s and mas-
ter’s theses.

5. An academic essay is a defined piece of writing which has a clear 
structure. The aim of an academic essay is to accustom the Students to 
scientific thinking and argumentation. An essay is not an empirical type of 
writing; however, scientific methods and concepts are used when referring 
to literature and/or data. An academic essay must focus on what is analysed, 
but not on what is described or ascertained; it is also referred to scientific 
literature (not experience) when general notions, assumptions and theories 
for specific material (not conversely) are used.  

6. An independent writing assignment can be set up for the Students 
in consideration of the aims prescribed in the subject studied. The aim of 
such type of writing is to incentivise the Students to independently make 
decisions, develop and prove their standpoints. The length of an independ-
ent writing assignment is determined by the subject teacher.

7. A research paper is a type of writing the essence of which is estab-
lished by the development of concepts or attitudes prevailing in scientific 
literature. It aims to investigate and more comprehensively examine sepa-
rate themes of the subject, to cultivate appropriate abilities in analysing 
scientific literature, to develop analytical and cognitive skills of dealing 
with scientific issues, as well as to enhance logical reasoning. Writing a 
research paper helps one learn the scientific language, acquire a scientific 
style of language, develop the ability to format (describe, compare, sys-
temise, interpret, quote right) a scientific text and compose a reference 
list.

The length of a research paper is about fifteen pages, unless otherwise is 
indicated by the subject teacher. 

8. An account of laboratory work is a type of written work in which 
data and findings of the performed research, as well as theory, method, 
procedure (process) and equipment (means) are presented to carry out this 
work. From a practical point of view, an account of laboratory work is 
the description according to which the reader can independently conduct 
research and be satisfied with its results. The length of an account of labora-
tory work is from three to eight pages.

9. A practice account is a type of written work whose main components 
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are: the aims and tasks1 set for practical training, a description of the place 
of practical training, the competences acquired during practical training, 
personal experience, generalisation and conclusions.

A practice account is from ten to twenty pages, excluding appendices. 
The Department preserves it until the author completes the corresponding 
study cycle.

10. A term paper is a type of written work (from 30000 up to 40000 
printed characters) which meets the requirements for scientific works of 
analytical nature. It enables one to expand and deepen his/her knowledge 
of the subject, as well as to develop the research skills. A term paper is 
presented to a research supervisor within the given time. The Department 
preserves it until the author completes the corresponding study cycle.

11. A bachelor’s thesis is a final research paper of general university 
studies which conforms to the requirements for scientific works of ana-
lytical nature. It aims to evaluate the Students’ analytical skills to assess 
other researchers’ works of the corresponding field, to successfully conduct 
research of the corresponding study field, and to clearly and reasonably 
formulate conclusions of the research. The length of a bachelor’s thesis is 
from 70000 to 80000 printed characters (up to fifty pages).  

12. A master’s thesis is a final research paper of the second study cycle 
which meets the requirements for scientific works of analytical nature and 
wherein Master’s Students uncover their research skills. They must be able 
not only to analyse the selected topic, to evaluate other researchers’ works 
of the corresponding field, to plan and competently perform research of the 
corresponding study field, to explicitly and reasonably formulate conclu-
sions of the research but also to deal with research problems of both theo-
retical and practical nature. The length of a master’s thesis is from 100000 
to 120000 printed characters (up to seventy pages). 

13. Practice of collective written work. This Description of the Proce-
dures provides for the possibility of collective written work. The aim of 

1	 The practical training plan for a cadet’s practical training is composed wherein the following are 
indicated:
	 - the cadet’s first name, last name, the place of practice and its supervisor;  
	 - the length of practical training, credits and hours;
	 - the tasks and objectives of practical training.
The practical training plan is signed by the supervisor. It is an integral part of a practice account – its 
appendices.
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such work is to collectively extricate a general yet complicated or compre-
hensive scientific and/or project-related problem whose solution apparently 
exceeds the student’s time limit and physical capabilities. Small groups are 
formed for such type of written work, usually from two to three Students, 
no more than five.

It is not recommended in the Academy to foresee collective research 
works or final research papers. In special motivated cases upon the decision 
of the Department one theme of a research work or thesis can be assigned 
to two Students in a parallel manner, thus realising the idea of a parallel 
independent research and planning.

The length of collective study work shall be one and a half or two times 
more than the afore-mentioned recommended length of independent writ-
ing assignments.

14. A digital version of the prepared final work is submitted in fixed 
electronic file format in accordance with the Academy’s provisions of the 
electronic document information system of theses, doctoral dissertations 
and their summaries. Works are preserved in departments in compliance 
with the Academy’s commandant’s approved plan of paperwork of the cor-
responding year under the provisions of the Law on Documents and Ar-
chives of the Republic of Lithuania.

III. STRUCTURE OF A FINAL RESEARCH  
PAPER AND ACADEMIC WRITING

15. Compulsory parts of written work shall be these:
15.1. title pages (for a thesis there are two title pages, for other type of 

written work – one);
15.2. the declaration of conformity and integrity (in theses);
15.3. a summary in the Lithuanian language (in theses); 
15.4. a summary in the English language (in theses);
15.5. a preface (if necessary), i.e. acknowledgements, dedications, etc.);
15.6. contents;
15.7. introduction;
15.8. a theoretical part (named according to the work’s theme);
15.9. a research part (named according to the work’s theme);
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15.10. conclusions;
15.11. recommendations (if there are such);
15.12. references;
15.13. appendices.
Other parts of written work may vary depending on its type and study 

programme.
16. A title page indicates the Academy, the Department wherein a paper 

has been prepared, the name of a study programme, the type of a scientific 
paper and its title, first names of the author and his/her thesis advisor, the 
place and years of writing a paper (Appendices 1–7).

17. The declaration of conformity and integrity is dedicated to con-
trolling independence of written work and its submission to the Depart-
ment. When submitting a paper, it must include the student’s and his thesis 
advisor’s signatures (Appendix 8).

18. Summaries. Summaries, written in the Lithuanian language and 
separately in the English language, provide a brief overview of a research 
problem, its methods / methodics and significant findings. They should 
comprise no less than 2000 printed characters. The author of written work, 
its title and a thesis advisor are indicated at the beginning of summaries. A 
research paper excludes summaries (Appendix 9).

19. Contents. It is the list of parts of written work, its titles and appen-
dices with reference to their pages. When the main parts of written work are 
divided into smaller ones and named, it is indispensable to mark them in the 
contents (Appendix 10). 

20. Introduction. It embraces the motives of selecting the theme of writ-
ten work, indicates its overall context, topicality, novelty, research problem, 
subject of research, aim(s), tasks, hypotheses, methods of research, practi-
cal applicability, and presents a short review of publications and references. 
Introduction may start in a preface.

21. A theoretical part discusses and analyses a research problem, pre-
sents aims and hypotheses (if formulated), states theses and arguments. A 
research problem must be put forward in investigating studies conducted 
by other authors specializing in that domain, defining the key notions and 
revealing the aims of research in an argumentative manner. It is a purpose-
ful analysis of scientific literature on a certain theme which helps the author 
of written work formulate aims and hypotheses, develop theses and argu-
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ments.
22. A research part is an indispensable part of empirical research. Its 

aim is to explicitly substantiate and comprehensively describe the process 
of scientific investigations and the applied research methods. This part pre-
sents, discusses and ascertains the findings of the research conducted. Re-
search data is examined in detail: its essence is analysed and interpreted.

23. Conclusions. These are short and generalised findings of the re-
search which are not evident before carrying out this scientific research. 
Every conclusion must be grounded in the main text of written work, 
emerge from the performed analysis and research and be connected with 
the aim, tasks and hypotheses of a scientific paper. Conclusions should not 
be too concrete iterating the obtained findings or appealing to concrete in-
dicators; also, they should not be very abstract, that is, deviate from the 
conducted research.

24. Recommendations. Concrete recommendations are provided for a 
specific organization, researchers or other subjects to develop future re-
search projects, practical activities.

25. References. All the published references mentioned in a scientific 
paper must be incorporated into a reference list. It includes the authors 
who have been mentioned in text. The reference list is presented in alpha-
betic order (according to the author’s first name) in conformity with the 
requirements of APA citation style (www.apastyle.org). The essential entry 
elements are the following: the author’s last name, first name or initials of 
the first name, a preface, the data of a scholarly reviewed publication, the 
place and year of publication and page numbers; when including an article 
from a collection of scientific papers or from periodicals, the following are 
indicated: title, volume, number and pages.

For example: 
References to books and other periodical articles
l	Dubauskas, G. (2011). Finansų valdymo teorijos. Vilnius: LKA.
l	Surgailis, G. (2013). Trečiasis pėstininkų Didžiojo Lietuvos kunigaikščio  

	 Vytauto pulkas. Vilnius: LKA.
l	Military academy of Lithuania. (2003). Handbook of military symbols:  

	 APP-6(A). Vilnius: Military Academy of Lithuania.
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References to the publications in collective monographs and other 
non-periodical articles  

l	Smolinski, A. (2008). Lenkijos kariuomenės „Lietuviškasis“ ulonų pulkas  
	 1918–1939 m. (G. Surgailis, Red.) Karo archyvas (XXIII), p. 246–262.

l	Ajzen, I., & Fishbein, M. (2005). The Influence of Attitudes on Behavior.  
	 (D. B. Albarracin, & M. Zanna, Red.) The handbook of Attitudes, p. 456–500.

References to the publications in periodical articles
l	 Janeliūnas, T. (2012). Lietuvos pirmininkavimo Europos saugumo ir  

	 bendradarbiavimo organizacijai dilemos ir pamokos. Lietuvos metinė  
	 strateginė apžvalga 2011–2012, 10, p. 61–88.

l	Dudzevičiūtė, G., Tvaronavičienė, M. (2011). Measurement Framework of  
	I nnovation Activity: Theoretical Approaches’ Analysis. Journal of Security 
	 and Sustainability Issues, 01 (1), p. 63–75.

References to the qualifying research paper
l	Onaitytė, O. (2012). Pilietiškumo ugdymas mokykloje. Magistro darbas. 

	 Kaunas: Kauno technologijos universitetas.

References to archival (manuscript) documents 
l	Karo komisijos įsakymai kariuomenei (1788–1798). Lietuvos valstybinis  

	 istorijos archyvas. Senieji aktai, Byla Nr. 4154.

References to legal acts 
l	Lietuvos kultūros paveldo skaitmeninimo koncepcija: Lietuvos Respublikos  

	 Vyriausybės 2005 m. rugpjūčio 25 d. nutarimas Nr. 933. (2005). Valstybės 
	 žinios (Nr. 105-3877).

References to patent documents 
l	Buteliauskas, S. (2012). Patent No. EP 1 778 918 B1. European Union.
The procedure for submitting a description of electronic documents. 

Using electronic sources of scientific literature, books in electronic space 
are indicated as printed ones. 

If there is a source of electronic documents, a database or other storage 
wherein the publication is presented in full volume, after a common refer-
ence to the publication the date of the reviewed source and the address of a 
website are indicated. If a source of electronic documents is interactive, that 
is, liable to change, for instance, the websites of institutions and organiza-
tions are constantly being updated, the source is referred to as interactive. If 
the source has a digital ID (DOI – digital object identifier, http://doi.org/), 
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it has to be written at the end of the reference.
For example:
l	Gaigalas, A. (2011). Pilietiškumo sampratos raida Lietuvoje. [žiūrėta  

	 2013-04-17]. Prieiga per internetą: www.elpilietis.edu/straipsniai.
l	Švietimo ir mokslo ministerija. (2000). Pilietinis ugdymas mokykloje:  

	 problemos. [žiūrėta 2013-04-17]. Prieiga per internetą: www.pilietinis- 
	 ugdymas.smm.lt/problemos.html.

l	Lietuvos statistikos departamentas. (2013). Gyventojų sudėtis [Interakty- 
	 vus]. [žiūrėta 2013-12-27]. Prieiga per internetą: http://osp.stat.gov.lt/temi- 
	 nes-lenteles19

l	Muldoon, K., Towse, J., Simms, V., Perra, O., & Menzies, V. (2012). A  
	 longitudinal analysis of estimation, counting skills, and mathematical  
	 ability across the first school year. Developmental Psychology. Advance  
	 online publication. doi:10.1037/a0028240

26. Appendices. This part of a scientific paper embraces concrete exam-
ples (researchers are faced with tasks, questionnaires, etc.) of more compli-
cated research methodologies, the answers of those who have been under 
research, the data of a more elaborate statistical analysis and other supple-
mentary material.

IV. GENERAL REQUIREMENTS FOR TEXT

27. Text formatting and segmentation. A scientific paper must be 
written in the correct Lithuanian language. Scientific terms, last names 
of authors and titles are written in accordance with the resolutions of the 
State Commission of the Lithuanian Language. If necessary, alongside the 
Lithuanian terms the equivalents in a foreign language can be indicated in 
parentheses.

A text should use Times New Roman font in 12pt and be written on 
white A4 paper with 1.5 line spacing. The title page should include the au-
thor’s last name and the full title of the paper which is written using Times 
New Roman 14-point font; the title is written in bold (Appendix 12).

A text appearing within the page has empty spaces swathing the top – 
20 mm, bottom – 20 mm, left – 30 mm and right – 10 mm edges of the 
paper. The Lithuanian inverted commas are used („ … “). In text, separate 
words can be written in bold.
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There is no extra space between paragraphs. The first line of the para-
graph is additionally indented to 1.5 cm from the edge of a page. Both 
edges of paragraphs are aligned.

Page numbering continues consistently, starting from a title page (the 
title page has no page number) and ending up with appendices. A page 
number is written at the bottom of the text in the centre of blank space in 
Arabic numerals, neither adding a dot nor dashes.

The text in the main part of written work is separated into chapters and 
subchapters, or if necessary, into subsections. These text parts are labelled 
in Arabic numerals (new numbers from the right are ascribed to the smaller 
ones), for example: 1.1., 1.2., 1.2.1., 1.2.2. (Appendix 11).

Every part and chapter of a scientific work should start on a new page. 
The titles of chapters are numbered, not carried over, written in capitals and 
centred. After them the full stop is not written. The titles of subchapters and 
smaller parts are written in minuscule, except for the first one.

The titles of parts as well as words such as INTRODUCTION, CON-
TENTS, CONCLUSIONS, REFERENCES in a scientific paper are written 
in bold one line lower than a margin begins, whereas the titles of chapters 
and subchapters are separated from a text going before or after them by one 
line spacing.

If there are appendices, they are presented at the end of written work 
after the reference list. A blank sheet of paper with a horizontally and verti-
cally centred title APPENDICES is inserted before them which is written 
in capitals in bold using 14-point font and included in the work›s contents. 
Appendices are titled and printed on separate pages. Separate appendices 
are not incorporated into the contents.

Final research papers must be printed in high quality and bound and 
have an attached envelope for reviews and a USB mass-storage device. 

28. Tables and figures. All tables, figures and appendices must have 
numbers and titles. Their numbering is separate. When numbering, one 
should write: Table 1, Figure 3, Appendix 4, etc (see Appendix 11). 

The capitalized table caption is written in bold above the table in the 
middle of the page, using 11-point font in minuscule. Numbering is in-
cluded in the title. If there is only one table in text, numbering is still used. 
The text in tables is presented in 10-point font. A capital letter is used to 
start a text in all table lines. The numbers in the table columns are distrib-
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uted such that groups of numbers in the whole column could go exactly one 
after another. Measurement units are enclosed by brackets in the captions 
for table columns. 

Figure captions and numbers beginning with a capital letter are written 
in bold below the figure in the middle of the page, using 11-point font in 
minuscule. 

In case there is not enough space for a table to be fitted on one page, 
the reduced table is inserted into text, while the entire table is presented in 
appendices.

Using other authors’ tables and (or) figures, it is indispensable to indi-
cate their authors and sources. The source is presented below the table / 
figure; if the table is composed of several sources, all sources are indicated.

It is possible to make one line spacing before and below the table / figure 
if the text of adjacent paragraphs is too close.

29. Citations and references. The sources of information in written 
work are cited to avoid plagiarism (a legal aim) and demonstrate that the 
author has familiarised with the topic under investigation (the aim of aca-
demic study), and that it is much easier to find the primary sources of infor-
mation (a practical aim). 

Plagiarism is “the appropriation of another author’s ideas, thoughts or 
expressions”. Plagiarism embraces literary theft (when copying) of another 
person’s words or ideas and the representation of them as one’s own origi-
nal work without referring to the source”2. In a broad sense, plagiarism is 
understood such that it is described in the study of possibilities for plagia-
rism detection of ETD documents.

APA citation style (http://www.apastyle.org/) is used at the Lithuanian 
Military Academy. When mentioning the author in text, the author’s last 
name is indicated in brackets in his native language (excluding the lan-
guages using non-Latin characters), the year and page of the publication 
wherein he has presented certain issues. For instance, citing another au-
thor’s thoughts is marked by inverted commas and the source is indicated.

For example:	
Jonikas (1999, p. 145) points out that “you must not generalise data un-

2	 Nevinskaitė, L. et al. (2008). The study of possibilities for plagiarism detection of ETD docu-
ments. http://biblioteka.su.lt/wp-content/uploads/ETD_dokumentu_plagijavimo_patikros_galimy-
biu_studija.pdf
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less you conduct representative research”. 
The field of scientific investigations being confined to the national level 

has recently been criticized a lot (Jonikas, 1999, p. 196).
Citing or indicating non-primary sources, one should primarily refer to 

the author of the work and then to its second author from whose publication 
the citation is introduced, for example (Freud, cit., according to Yallom, 
2004, p. 34).

When there are three or more authors, in providing a reference only the 
first author’s name is indicated and added “et al.”, for example (Murauskas 
et al., 2003, p. 72), (Mielle et al., 2001, p. 28).

If the author’s source is an organisation or a source excluding the author, 
in providing a reference only the name and year of the organisation or the 
source are mentioned, for example (NATO’s glossary, 2011, p. 46).

In particular cases, when a source of information has no written form or 
is not published, e.g. a recording or conspectus of a scientific conference, 
the reference to such source of information can be written by using a num-
bered footnote at the bottom of the page.

V. ASSESSMENT OF FINAL RESEARCH 
PAPERS AND ACADEMIC WRITING

30. Final research papers and academic writing are assessed under the 
guidance of the Academy’s Students’ assessment system in accordance 
with the following criteria:

30.1. the subject of a research paper, aims and tasks, hypotheses (if for-
mulated), research methods – clarity, relevance or feasibility of an object, a 
research problem, aims and tasks, research questions, hypotheses and vari-
ables, congruency between research problems, novelty and topicality of a 
research paper;

30.2. an educational / theoretical part deals with congruency of research, 
its analytical elaboration, an extensive list of scientific literature, the use of 
the most recent literature, an immense amount and refinement of empirical 
data, substantiation of thesis statements, lucidity and validity of research 
findings;

30.3. a practical / analytical part focuses on how the selected research 
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methods conform to the aims of written work, a variety of the applied meth-
ods, elaboration of data analysis, substantiation / disapproval of hypotheses 
(if formulated), sufficiency of literature being analysed to validate the solu-
tion to a research problem;

30.4. conclusions and recommendations are clarity of conclusions, their 
compliance with the findings of the research, evaluation of written work’s 
theoretical and (or) practical significance, explicitness and relevance of ap-
proaches and recommendations (if formulated), presentation of further re-
search perspectives;

30.5. the thesis defense has to do with the Students’ abilities to briefly 
describe the essence of written work, to put forward a research problem, 
object, aim and tasks, to present research methods and clarify its findings, 
to answer questions and remarks, as well as to provide approaches and 
recommendations;

30.6. complying with the requirements for form is associated with rel-
evance of the length of written work, conformity to the requirements set 
for the structure of written work, sustainability of structural parts and cor-
respondence of their titles to the text written, an efficient use of tables and 
figures, presentation of questionnaires and statistical data, the use of scien-
tific language and language correctness.

31. The description of assessment:
31.1. excellent (10) – an original, distinctive scientific investigation 

having neither subject nor form drawbacks;
31.2. very good (9) – an original scientific investigation with the draw-

backs of form only (proof, bibliography formatting);
31.3. good (8) – an analytical research work which has some minor sub-

ject and form related drawbacks;
31.4. highly satisfactory (7) – a research work lacking a more compre-

hensive analysis wherein there are minor subject and form related draw-
backs;

31.5. satisfactory (6) – a research work lacking analysis wherein there 
are major subject and form related drawbacks;

31.6. sufficient (5) – a research work which has the essential subject and 
form related drawbacks, but still satisfies minimum requirements;

31.7. insufficient (4) – a research work which does not satisfy minimum 
qualification requirements.
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32. A research work which is not prepared on time or prepared irrel-
evantly is neither accepted nor assessed. 

VI. INDEPENDENCE OF FINAL RESEARCH 
PAPERS AND ACADEMIC WRITING

33. Both final research papers and academic writing are prepared au-
tonomously. Having found out that an academic piece of writing or a thesis 
has not been prepared independently, a work is not assessed and the com-
mandant of the Academy is informed about this fact in writing who will 
decide upon the expulsion of the student from the Academy.

34. An academic work is considered independent if:
34.1. it conforms to the established requirements on page 29;
34.2. the authors’ interests and intellectual rights are not violated in 

written work;
34.3. the whole work or part of it has not been encountered within an-

other course in the Academy or other education institutions;
34.4. it does not include the cases of plagiarism by computer-assisted, 

electronic or other means which are evaluated by the commission of the In-
stitute of University Studies, established to consider an instance of literary 
theft. Its conclusions are final and no appeal shall lie from them.

VII. SELECTION OF THE THEME  
FOR A FINAL RESEARCH PAPER

35. The themes for bachelor’s theses of the first cycle of regular stud-
ies are proposed by departments in the fifth semester of the third year of 
studies, and as for extended studies – in the sixth semester of the third year 
of studies. Departments provide themes for master’s theses of the second 
cycle of studies in the first semester of the first year of all study forms. 

36. Together with thesis advisors both an individual student and a group 
of the Students (no more than two) may select a theme of written work from 
the list submitted by the Department.

 37. The student may himself reasonably propose a theme and a thesis 
advisor to the Department.  
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38. The paper’s theme can be changed only with the consent of the Head 
of Department.

39. The selected and coordinated themes for final research papers of the 
first cycle of regular studies are approved by Order of the Commandant of 
the Academy until the end of the fifth semester of the third year of studies, 
and as for extended studies – until the end of the sixth semester of the third 
year of studies.

VIII. PREPARATION FOR A FINAL  
RESEARCH PAPER

40. The student or a group of the Students prepare a thesis indepen-
dently in conformity with the approved methodological guidelines:

40.1. make a thesis plan, create a schedule for its completion and follow 
it;

40.2. systematically accumulate and examine scientific literature and 
sources;

40.3. constantly consult a thesis advisor and regularly inform him about 
the process of writing a paper and emerging challenges;

40.4. submit in parts and the whole project text as well as the thesis plan 
to a thesis advisor and take account of his remarks and recommendations;

40.5. with the consent of a thesis advisor submit a fully prepared thesis 
both to the Department for registration and to a reviewer within the given 
time.

41. An educational specialist or researcher with a degree is appointed as 
a thesis advisor (it can be a person holding a master’s degree or higher). A 
thesis advisor:

41.1. advises the student on scientific literature, searching for informa-
tion, methods and methodology, helps to resolve research problems;

41.2. systematically guides the process of writing a thesis, according to 
its outlined plan and implementation schedule; 

41.3. reviews the thesis project, passes remarks and recommendations 
for its improvement;

41.4. proposes to permit (permits) / forbids the thesis defense at the 
Department;
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41.5. participates in the public thesis defense and scientific discussion;
41.6. The department wherein a final research paper is prepared permits 

or forbids the public thesis defense by referring to the following:
41.6.1. general and subject-related requirements for written work;
41.6.2. language correctness;
41.6.3. compliance with the norms of academic ethics;
41.6.4. the results of the thesis defense at the Department.

IX. PREPARATION FOR THE DEFENSE  
OF A FINAL RESEARCH PAPER

43. The Students are permitted to defend their theses if they have com-
pleted the whole programme of studies. It is permitted to defend a thesis 
under Order of the Commandant of the Academy.

44. Theses are defended within the time stated in the Academy’s study 
schedule.

45. A thesis can be defended only with the consent of a thesis advisor. 
He must inform the student about his decision (proposal) to permit or for-
bid the thesis defense no later than one week before the first meeting of the 
Thesis Committee.

46. If a thesis advisor does not approve of the fact that a thesis has been 
prepared properly and can be defended, the student has the right to address 
the Thesis Committee with a request to allow him to defend a final research 
work by stating the motives in writing. The student must submit a request to 
defend a thesis to the director of the Institute of University Studies no later 
than until the first meeting of the Committee. A requester’s arguments and 
final research work are considered by the Thesis Committee which decides 
whether or not the student is permitted to defend a thesis. If he is allowed 
to defend it, a reviewer is appointed.

47. The Thesis Committee is composed under (in consideration of) the 
regulations of study programmes approved by the Minister of Education 
and Science and (or) implementation descriptions, and is approved by Or-
der of the Minister of National Defence.

48. The Head of Department appoints a reviewer to whom the student’s 
thesis is handed. To review theses, it is recommended to invite social part-
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ners and workers from other subdivisions (institutions).
49. A reviewer presents his recommendations and report on a scientific 

paper in writing to the Department or the Thesis Committee no later than 
two days before the thesis defense.

50. Before submitting his thesis for defense, the student signs the decla-
ration of integrity (Appendix 8), confirming that a thesis is prepared inde-
pendently without violating other authors’ intellectual property rights, and 
attaches it to a final research paper. Having detected the cases of plagia-
rism which have been ascertained by a thesis advisor along with the Head 
of Department, the Head of Department informs the commandant of the 
Academy about the afore-mentioned cases in written form. The Academy’s 
commandant decides upon the expulsion of the student from the Academy.

X. THE DEFENSE OF A FINAL  
RESEARCH WORK 

51. The thesis defense is public and takes place in the meeting of the 
Committee set by Order of the Minister of National Defence.

52. On the day of defense the Department submits a final research paper, 
an advisor’s written consent to defend a thesis and a reviewer’s report to the 
Thesis Committee.

53. Upon the decision of the commandant of the Academy, a final re-
search paper whose results shall not be publicised can be defended in a 
closed meeting of the Committee. Then part of the meeting is announced 
by the Committee as closed.

54. During the thesis defense the author presents a brief overview of 
his final research paper by indicating the research problem, its object, aim, 
tasks, describes the research object, introduces research methods, ascer-
tains the findings obtained, novelty and topicality of the methods applied 
during the research, presents the key conclusions and substantiates them, 
provides recommendations, and answers the questions asked by the mem-
bers of the Committee, a reviewer and others.

55. After the student’s presentation and his answers a reviewer (if he 
participates in the defense) familiarises the Committee with a review and a 
thesis advisor expresses his opinion about written work. If a thesis advisor 
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or a reviewer is unable to participate in the thesis defense meeting (due to 
the justified reasons), their reports are read by the Committee Secretary. 
The student answers the reviewer’s and Committee members’ questions.

56. Having determined the case of plagiarism during the thesis defense, 
the chairman of the Thesis Committee in writing informs the commandant 
of the Academy about this fact. The Academy’s commandant decides upon 
the expulsion from the Academy.

57. The Thesis Committee acts under the regulations approved by the 
commandant of the Academy.

58. Having successfully defended a thesis, the Committee awards a 
degree and (or) qualification to the student as referred to in a study pro-
gramme.

59. A report on the thesis defense is signed by all members of the Com-
mittee participating in the defense.

60. The decision of the Committee is final and no appeal shall lie against 
it.

61. The statement of the Committee is submitted to the Department of 
Studies no later than one business day after the thesis defense.

62. After the defense a thesis is returned to the Department wherein it is 
preserved in the manner prescribed.

63. The student who has not defended his thesis and failed to defend it 
is expelled from the Academy.

XI. CONCLUSIVE PROVISIONS 

64. All other questions unforeseen in this Description of the Procedures 
shall be resolved by the Administration of the Academy.   
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Academic assay
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Appendix 2. Title page for an individual writing assignment

The General Jonas Žemaitis Military Academy of Lithuania
Department of Political Sciences 

VARDENIS PAVARDENIS

THE CONCEPT OF SYMBOLIC POWER

Individual writing assignment
Study programme: International Relations 

Study field: Political Sciences

	

	 Lecturer
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Vilnius, 2014
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Appendix 3. Title page for a research paper

The General Jonas Žemaitis Military Academy of Lithuania 
Department of Management

VARDENIS PAVARDENIS

STRATEGIC PLANNING IN THE PUBLIC SECTOR

Research paper
Study programme: Personnel Management

Study field: Public Administration
	

	 Lecturer
	 doc. dr. Vardžius Pavardutis

Vilnius, 2014
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Appendix 4. Title page for laboratory work

The General Jonas Žemaitis Military Academy of Lithuania
Department of Engineering Management

VARDENIS PAVARDENIS

SYNTHESIS OF SODIUM PICRATE  
AND ITS QUALITY ASSESSMENT

Account of laboratory work
Study programme: Management of Modern Defence Technologies

Study field: Management

	R esearch supervisor
	 doc. dr. Vardžius Pavardutis

Vilnius, 2014
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Appendix 5. Title page for a practice account

The General Jonas Žemaitis Military Academy of Lithuania
Department of Management 

VARDENIS PAVARDENIS

XXXXXXX XXXXXXXXX XXXXXXXXXXXX

Practice account
Study programme: Personnel Management

Study field: Public Administration

	 Practice supervisor
	 doc. dr. Vardžius Pavardutis

Vilnius, 2014
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Appendix 6. Title page for a term paper

The General Jonas Žemaitis Military Academy of Lithuania
Department of Engineering Management 

VARDENIS PAVARDENIS

THE ORGANISATION OF OCCUPATIONAL SAFETY  
IN THE TRANSASPORTATION OF DANGEROUS GOODS

Term paper
Study programme: Transport and Logistics

Study field: Business

	

	R esearch supervisor
	 doc. dr. Vardžius Pavardutis

	

Vilnius, 2014
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	A ppendix 7. Title page for a final research paper 

The General Jonas Žemaitis Military Academy of Lithuania
Department of Management

VARDENIS PAVARDENIS

A COMPARATIVE ANALYSIS OF INTEGRATIVE  
COMPETENCIES OF MANAGERS FROM  

THE PERSPECTIVE OF SUSTAINABLE DEVELOPMENT

Bachelor’s thesis
Study programme: Personnel Management

Study field: Public Administration

	

	 Thesis advisor 
	 doc. dr. Vardžius Pavardutis

Vilnius, 2014
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	A ppendix 7. Title page for a final research paper 

The General Jonas Žemaitis Military Academy of Lithuania
Department of Management

VARDENIS PAVARDENIS

A COMPARATIVE ANALYSIS OF INTEGRATIVE  
COMPETENCIES OF MANAGERS FROM THE  

PERSPECTIVE OF SUSTAINABLE DEVELOPMENT

Study programme: Personnel Management 
Study field: Public Administration

Consultant			   Thesis advisor 

UAB „Kokia nors įmonė“, direktorius

Signature	 Vardenis Pavardžius  	 Signature 	doc. dr. Vardžius Pavardutis

…May 2014			   …May 2014	

Reviewer    			   Thesis prepared by
			   414 būrio kariūnas

Signature	 prof. dr. Vardis Pavardauskas	 Signature	 Vardenis Pavardenis

…May 2014			   …May 2014	

Thesis accepted in digital form	

Signature	 Vardenė Pavardenytė	

…May 2014		

Vilnius, 2014
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	A ppendix 8. The declaration of conformity and integrity

The General Jonas Žemaitis Military Academy of Lithuania 
Department of Management

Vardenis Pavardenis

(Student’s first and last name)

Personalo vadyba

(Study programme)

THE DECLARATION OF CONFORMITY  
AND INTEGRITY OF THE THESIS (PROJECT)

25 May 2014

(Date)

I hereby confirm that this prepared thesis (project) on the theme “A comparative analysis of 
integrative competencies of managers from the perspective of sustainable development”, which was 
approved by Order of the Commandant of the Academy, No.  of , 
has been written independently and has never been submitted at the Military Academy of Lithuania 
or any other educational institutions for the conferral of a degree. 

The material presented in this thesis (project) is not plagiarised. All the sources of information 
utilized in this thesis are cited and included in a list of references. 

Other persons have not contributed to this final research work. I have not paid any sums of 
money to anyone for this paper.

Collecting and evaluating the material as well as preparing the thesis (project), I was consulted 

by researchers and specialists: 

Research supervisor   Assoc. Prof. Vardžius Pavardutis
                                            (Signature)

	  	Thesis is in partial fulfilment of the requirements and can be defended.

	
 	Thesis cannot be defended. Reasons:

Thesis author     	
                           (Signature)                                                     (First name, last name, write in hand)   
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	A ppendix 9. Summary 

Pavardenis, V. (2014). A comparative analysis of integrative competences of manag-
ers from the perspective of sustainable development / Final bachelor‘s thesis in Public 
administration. Supervisor Assoc. Prof. V. Pavardutis. Vilnius: Department of Manage-
ment, The General Jonas Žemaitis Military Academy of Lithuania.

SUMMARY

The summary should include the description of the current relevance of the per-
formed work, specify the problem it deals with, the object, the aim and the tasks of the 
research, the hypotheses (if they were formulated); methodology of the research (used 
methods and reasons of their selection); work results and interpretations; conclusions 
(most important evaluations, suggestions), accepted and rejected hypotheses (if there 
were any).

Keywords.
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	A ppendix 11. The examples of presenting  
a thesis structure, its tables and figures

1. Integrative competencies of managers 
and sustainable development

1.1. AN overview of integrative competencies
It may appear that no one might take an interest in such clear topic as integrative 

competencies. However, a wide spectrum of reliable sources of literature demonstrates 
(Munjab & Montana, 1975) that <...>.

1.2. SUSTAINABLE DEVELOPMENT IN CONTEMPORARY SOCIETY
Several years ago mankind came to realise (Adams, 1979) that natural resources are 

not infinite, and therefore advised neighbouring countries to save more <...>.

1.2.1. The history of sustainable development
Sustainability is inextricably entwined with another concept of surplus population. 

As Figure 1 shows, over the last few decades in Lithuania there has existed a reverse 
<...>.

Figure 1: Total population in Lithuania (United Nations Population Division, 2012)

In the most favourable view, if over the coming fifty years the population in the larg-
est cities in Asia <…>. 
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1.2.2. Sustainable development in Lithuania and abroad
When comparing the dissemination of the concept of sustainable development in 

different countries <...>.

2. A COMPARATIVE ANALYSIS OF INTEGRATIVE  
COMPETENCIES OF MANAGERS

2.1. METHODOLOGY OF THE SURVEY OF MANAGEMENT PRACTICES
The analysis of literature has demonstrated that there exists a wide range of integra-

tive competencies of mangers. Pursuing to ascertain the present situation in Lithuania, a 
scientific investigation has been carried out whose major parts <…>.

2.2. THE RESULTS OF THE SURVEY OF MANAGEMENT PRACTICES
This part presents the results of the research lasting for one and a half years. One 

hundred forty five managers of leading companies in Lithuania were interviewed <...>.

2.2.1. The distribution of the results of the survey according to countries
The conducted internship enabled the author of the research to compare the results in 

several countries. Table 1 briefly presents the results.

Table 1: Weighted results of the survey of mangers in various countries

Country Number of respondents Weighted result
Lithuania 110 108,59

Latvia 50 218,60
China 36 98,4336

Referring to the error of the results of the performed research, one can state that <...>.

2.2.2. The dependency of the results of the survey on the season
On the contrary (Mainelli, 2011, p.2), the managers’ answers (Appendix 1) do not 

show a direct correlation with a room temperature during an interview. This can be ex-
plained by their thick skin <…>.

2.3. THE ANALYSIS OF INTEGRATIVE COMPETENCIES OF MANAGERS
Evaluating the results of the research, one primarily concentrates on these major dif-

ferences between the afore-mentioned <…> in literature.  

2

Appendix 11. The examples of presenting  
a thesis structure, its tables and figures
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Appendix 12. Recommendations for the layout of written work

In this Appendix of written work the recommendations for automating several im-
portant steps of text formatting by using Word 2007 (or its newer version) are presented. 

A. TEXT STYLES
Word will generate a table of contents automatically and format text before describ-

ing paragraph styles used in written work.

A.1. The Normal style

On the Home tab, under Styles, 
click next to the style, and then 
click Modify Style.

Setting parameters: use a 
12-point Times New Roman 
font with 1,5 line spacing, press 
the Justify Button image, click 
Format and select Paragraph.   
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Indent the First Line to 1,5 cm. 
Verify that there is no Spacing 
Before and Spacing After – 0 
pt, while Line spacing must be 
1,5 lines.
Save the parameters by clicking 
OK.
In another opened window, click 
OK again. 

A.2. TThe Heading 1 style 

Analogically, set the Heading 1 
style parameters. Here you must 
choose the Centre Button image 
(not Justify). 

2
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Click Font on the Format menu. 
In the Font dialog box, under Ef-
fects, select the All Caps check 
box, choose Bold from the Font 
Style combo box, and then click 
OK.   

In the Paragraph group on the 
Home tab, under the Indents and 
Spacing, click Line spacing and 
select 1, and then click an arrow 
next to Spacing Before and enter 
12 pt. 

3
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In the Line and Page Breaks tab, 
tick the Page break before option, 
and click OK.  

A.3. TThe Heading 2 style 
Heading 2 is used to include titles of chapters. Its setting is identical to Heading 1 

with the exception that you choose Regular instead of selecting Bold, use no spacing 
in the Spacing Before option (ParagraphSpacing Before0pt), while under Spacing 
After you select Single-line spacing (ParagraphSpacing After12pt). Neither should 
a text start on a new page (ParagraphLine and Page BreaksPage break before, i.e. 
Page break before should not be ticked).

A.4. The Heading 3 and Heading 4 styles 
These styles are utilized to incorporate headings and sub-headings. They differ from 

Heading 2 in the way that the text presented in the Heading 2 style is written in minus-
cule (except for the first letter), wherefore all the settings correspond to Heading 2 with 
one exception that in the Font section you should not tick the All Caps option.

A.5. The style of introduction, conclusions, recommendations,  
references and appendices 

You have to create a special paragraph style for such parts of written work as Intro-
duction and Conclusions, for these parts are not numbered but must be incorporated into 
Contents.

4
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If you want to create your 
own style, you have to click 
an arrow in the lower right 
corner of the Styles group 
on the Home tab. 
In the opened window, click 
the New Style Button. 

In the New Style window, 
write the selected name, 
for example ĮVADAS, and 
then format as the Heading 
1 style, that is Caps and 
Bold (Formatà FontàAll 
Caps and FormatàFontà 
Bold), Centred,  
Spacing Before and After 
(FormatParagraphà 
Spacing Before12pt and  
FormatParagraphà 
Spacing After12pt), and  
Page break before 
(FormatParagraphà 
Line and Page Breaksà 
Page break before needs 
ticking).  

A.6. Numbering of chapters 
Chapters are automatically numbered.

Appendix 12. Recommendations for the layout of written work
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On the Home tab, in the Para-
graph group, click Multilevel 
List.  

Then you select Define New 
Multilevel List.

Here you can see a comprehensive list wherein you additionally have to click More, 
making it even a bit more detailed.

In the Number style for 
this level box, set number-
ing 1, 2, 3, …, link the first 
level of numbering with 
Heading 1 under Link lev-
el to style and select Space 
in the Follow number with 
box. Do not close the win-
dow! 

Now you have to set page numbers of the second level.

Appendix 12. Recommendations for the layout of written work
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Choose Number 2. 

Then select the Heading 2 style 
for the second level.

Choose a relevant style of num-
bering in the Enter formatting 
for number box wherein an entry 
1. 1. will have to appear (i.e. 1, the 
period and space, then 1 and the 
period). It is important that you 
not use the keyboard to type 1!
To include numbers, delete the 
whole text in the Enter format-
ting for number box by using 
the BACKSPACE key and select 
Level 1 under Include level num-
ber from.   
An entry 1 will appear in the En-
ter formatting for number box.

Using the keyboard, write the pe-
riod and insert space next to 1 and 
then select 1, 2, 3, … under Num-
ber style for this level. 
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Then once again di-
rect the cursor to the 
Enter formatting 
for number box and 
write the period at 
the end of the entry. 
Select Space under 
Follow number with.

Page numbers of other levels must be set analogically (i.e. numbers of the third level 
must be linked with the Heading 3 style, and when describing page numbers, one has to 
use numbers of the previous level (i.e. Include level number from)). 

Closing this window, all paragraphs written in Heading 1, Heading 2, etc. styles will 
be properly numbered; creating a new chapter or sub-chapter, the rest will be automati-
cally numbered.

A.7. The use of styles 
If you want to transform a sentence into the chapter title, you should direct the cursor 

to that paragraph, and then select a desirable name of style on the Home tab. For exam-
ple, if you select the Heading 1 style, a paragraph will immediately move to a new page 
(as the text of the Heading 1 style always starts on a new page) and be written in capital 
letters. If you change the place of chapters or subchapters, they will be automatically 
numbered in the right order.



44

9

Appendix 12. Recommendations for the layout of written work

B. AN Automatic table of contents (toc) 
Setting a style makes it possible to create an automatic table of contents. One can 

easily create a table of contents which includes all headings (Heading 1, Heading 2 and 
other styles) being present in the text (on the References tab, in the Table of Contents 
group, click Table of Contents). However, in this case you should additionally incorpo-
rate several special parts of text such as Introduction, Conclusions and the like. In other 
words, a table of contents must include not only heading styles but also our created style 
ĮVADAS.

Click where you want to in-
sert the table of contents. On 
the References tab, in the Ta-
ble of Contents group, click 
Table of Contents, and then 
click Insert Table of Con-
tents. 
Click Options. 
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Write 1 next to ĮVADAS and 
double-click OK.  

Later, when the place of text in the document or chapter titles have changed, the cre-
ated table does not need recreating – one has just to update it.    

To update the table of contents, 
right-click on the present contents 
and select Update Field.  
Select Update entire table in the 
Update Table of Contents dialog 
box and click OK.

C. Tables and figures
In Word, it is possible to automatically number various objects – tables, figures and 

so forth. You can create in-text references for the mentioned objects and easily number 
them when the number for an object is changed.

C.1. Table numbering 
It is necessary to number and name tables. When you have created a table in the text, 

leave your cursor rest in the created table. Select Insert Caption on the References tab.   
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If a table is numbered for the 
first time, one may have to cre-
ate the name for the object (i.e. 
the word itself Table). If there is 
no possibility to select Table in 
the Label list or the list does not 
provide the correct label, click 
New Label, type the new label 
in the Label box, and then click 
OK.

Since the number for a table in 
Word is given at the end not at 
the beginning, you have to do it 
manually, that is tick Exclude 
label from caption.

Under Caption, write space, Ta-
ble, the period, and the title for a 
table using a capital letter. 
Set the caption position to 
Above selected item and click 
OK.  

If the title of a table automatically becomes blue (or is selected not in 11pt, Bold), 
then choose Caption in the Styles group. 
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C.2. Figure numbering 

Select any figure in the text, 
and on the References tab, 
in the Captions group, click 
Insert Caption. On the Cap-
tion dialog box, select Label: 
Figure (if there is no such, 
then create it by clicking New 
Label).
Set the position of the caption 
to as Below selected item.  
Tick Exclude label from cap-
tion so that only number can 
remain in the title. 
Then, in the Caption section, 
type Figure, the title for an im-
age and click OK.  

C.3. References to tables and figures 
When you have mentioned your table, figure or any other object in the text, you have 

to number them. If you change the table’s number later (e.g. insert another table before 
the existing one), you will have to review the whole text searching for wrong referenc-
es. Word allows one to create special references to objects (tables, figures and the like) 
which are automatically numbered.

For example, when writing a sentence “Referring to Figure 5 <…>”, you use the ref-
erence to Figure 5. In this case, Number (5) does not need typing by using the keyboard.

Introduce text (e.g. “Referring to 
<…>”). 
On the References tab, in the Cap-
tions group, click Cross-reference. 
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Select the reference type Figure 
and under Insert reference to 
choose Only label and number. 

Click Insertà Close, insert Fig-
ure and so forth.  

If you move the cursor to the reference (Number “5”) in the text, a gray background 
will have to appear (automatic field). 

If figure numbering has been 
changed in the document (you have 
inserted a figure or deleted several 
ones), it is easy to renumber them 
all in the document. 
All you have to do is select the 
desired part of the document (e.g. 
hold Ctrl while pressing the A key 
and the whole document will be se-
lected).     
Then you right-click on any auto-
matic reference in the text (in our 
example – gray Number “5”) and 
select Update Field. 
If you see the Update Table of 
Contents box, select the Update 
entire table option. 
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D. a reference list and Citations 
Writing a paper, you can right away insert a list of sources you are interested in even 

if you are not citing them at that time.  Later, you will find it easy to cite works from 
your inserted list and automatically create the list of all the sources cited in the document 
(bibliography). All necessary items of information are presented in the Citations & Bib-
liography group on the References tab.

Pay attention to the existence 
of different styles of citation. 
In this case, you must adhere to 
APA citation style.  

D.1. Creating a list of sources

If you want to include a 
book, an article or an In-
ternet address in the list of 
references, you should se-
lect Manage Sources on 
the References tab and click 
New. 

In the Create New Source window, use the Type of Source drop-down menu to se-
lect what kind of material you are referencing on which the number and quantity of fields 
will depend. It is recommended that author names be inserted by clicking Edit (it will be 
indicated where to add Last and First names).  If the author is not a natural person, then 
you should select Corporate Author. If it appears that there are not enough fields for the 
information to include, you can tick the Show All Bibliography Fields option to make 
all the possible fields to emerge. When the cursor rests on any entry field, the explanation 
what you will have to add is presented at the bottom of the window.

According to APA style, not all entered data will appear in the bibliography; however, 
it is worth selecting as much as possible, for this information will remain in the electronic 
document.
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If there is no desired type in the Type of Source option, you will have to select one 
which is closer according to the list of data field. For example, legal acts may fall into the 
Article in a Periodical category, while theses go with Report. In some cases it, however, 
may not be suffice, then you will have to enter plenty of information into one field of 
information (e.g. if you happen to realise that it is necessary to include the name of your 
scientific advisor in a final paper, you will have to type it at the end of the Title option). 

It is worthwhile mentioning that the Pages option is designed for indicating a page 
interval (e.g. pp. 68–99) rather than the volume of work. The document scope is not 
indicated in APA citation style. 

D.2. Citation 

If you have a list of sources, 
you can easily insert a refer-
ence/text.
On the References tab, click 
Insert Citation and select the 
desired source.
If there are many of them, 
then you can click Search Li-
braries<…>.
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If you want additionally indi-
cate the page from which the 
text is cited, you should click 
on the inserted reference and 
choose Convert citation to 
static text in the opened win-
dow. The reference converts 
to static text. 
Enter the page number. (Mainelli, 2011, p.12)

D.3. Creating a reference list
Having written your final research paper, you have to create a list of all the sources 

cited in your work (bibliography).

Place the cursor to a new page of 
the document and then click Bib-
liography on the References tab.

The Bibliography word appears 
in the document and the reference 
list is presented in alphabetical 
order.  
Delete the Bibliography word, 
write LITERATŪRA instead, se-
lect the ĮVADAS style, and then 
update the contents of the docu-
ment (there will appear a new 
item LITERATŪRA).

You will have to slightly modify this automatically created list of references as not all 
data is written in correct Lithuanian. One must modify the following points:

l 	the way the date of reading an internet source is presented (e.g. “Retrieved on 17  
		A  pril 2013” must be replaced by “žiūrėta 2013-04-17”);
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l		the way page numbers are presented (e.g. write “p. 46–48” instead of  
		  “pp. 46–48” (it can be done by click Find-Replace));
l 	contractions (i.e. write “Red.” instead of “Eds.”). 
NOTE: If you want to update the bibliography, all these changes in the reference list 

will be deleted; therefore, changes must be made at the very end before submitting your 
final paper.  

Appendix 12. Recommendations for the layout of written work
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